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Signature Staff

More about the
San Diego Signature

Managing Editor
Catherine Robinson
stcsignature@yahoo.com

Assistant Editor
Jennifer Mallory
jmallory100@hotmail.com

Copy Editors
Pamela Fridie
spfridie@nethere.com

Beth Vollbach
bethvollbach@earthlink.net

Graphic Designer
Fabrizio Scippa
fs@fsdsgn.com

Proofreaders
Theresa Freese
taffyfreese@cox.net

Mark Hall
mark@hallmark-consulting.com

Karie Hebert
karebear18@cox.net

Suzanne A. Hosie
suzy@wote.com

Kitt Medrano
kitt.medrano@wote.com

Bonnie Nicholls
bnicholls@cox.net
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About the San Diego Signature

 

Reach hundreds
of technical
communicators
for little cost!
Advertising Rates

Signature is the newsletter of the San Diego Chapter of the Society
for Technical Communication, a nonprofit professional organization
dedicated to educating and advancing the careers of technical
communicators. Newsletters are published monthly during the
chapter year (September through June).

STC has more than 25,000 members and 150 chapters nationwide.
For more information about the San Diego Chapter visit our Web site
at www.stc-sd.org or call our hotline at (619) 525-7716. Write to us
at:

STC San Diego
PO Box 501261
San Diego, CA 92150-1261

Article Submission

This newsletter invites writers to submit articles to be considered for
publication. Send your query and request for writer's guidelines to
stcsignature@yahoo.com. Submission deadlines are the 1st of the
month prior to the publication month. Publication is dependent on
space availability.

By submitting an article, you implicitly grant a license to this
newsletter to run the article and for other STC publications to reprint
it without permission. Copyright is held by the writer. In your cover
letter, please let the editor know if this article has run elsewhere,
and if it has been submitted for consideration to other publications.

Unless otherwise noted, copyrights for all newsletter articles belong
to the authors. The design and layout of this newsletter are © San
Diego STC, 2003.

Permission to Republish

Material published in Signature may be republished if Signature and
the author are credited. After publication, send a printed copy to the
editor at the above address. If the publication is electronic, e-mail
the newsletter URL or PDF to stcsignature@yahoo.com.
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Signature Advertising Information  

Got questions?
Comments? Want to
place an ad? Contact the
editor at
stcsignature@yahoo.com

Publication Overview

Signature is a Web newsletter published by the San Diego Chapter, Society
for Technical Communication (STC). It is issued ten times a year to more
than 300 local technical communication professionals, managers, and
educators. Other STC chapters, special interest groups, and related
organizations also receive e-mail notification when each issue is posted.
Because Signature is on the World Wide Web, readership is potentially
unlimited.

Signature contains information produced by technical communicators for
technical communicators. Advertising in Signature is the most direct way to
reach the growing technical communications market in San Diego and the
surrounding area.

Publication Schedule

Signature is published every month except July and August. Each issue is
posted on the Web within the first three days of the issue month. Closing
date for advertising is the 10th of the prior month.

Advertising Rates

Rates are based on type of ad (banner, rectangle, button, or text link), which
newsletter page it is on (home page, feature article, or other), and where it
is on the page (top, bottom, or side).

The following discounts apply:
Prepayment for five issues: 10 percent discount●   

Prepayment for ten issues: 20 percent discount●   

Horizontal Banner (see samples at top and bottom of this page)
Home page at bottom: $50
(Top not available.)

Feature article at top: $40
Feature article at bottom: $30

All other articles at top: $30
All other articles at bottom: $20

Medium or Vertical Rectangle (click to see samples)
Editor's Desk at right: $50
Presidential Podium at right: $50

Vertical Banner (see sample at right side of this page)
Feature article at right: $40
All other articles at right: $30

Button (see samples at right side of this page)
Home page at bottom: $40
(Space at the top is not available.)

Feature article at right: $30

All other articles at right: $20

Text link (see samples at right side of this page)
Home page at bottom: $30

Feature article at right: $20

Save BIG on books!

XML Revealed at Last!
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All other articles at right: $10

Specifications

File format: gif (non-animated only) or jpeg
Maximum file size: 18K
Horizontal Banner: 468 x 60 pixels
Medium Rectangle: 300 x 250 pixels
Vertical Rectangle: 240 x 400
Vertical Banner: 120 x 240 pixels
Button sizes: 120 x 90 or 125 x 125 pixels
Text link: No more than 2 lines per ad; no more than 21 characters
(including spaces) per line

(Sizes based on Internet Advertising Bureau Standards)

Submission Requirements

Submit advertisement by e-mail to stcsignature@yahoo.com. Include contact
name and phone number.

If the ad is supposed to link to a Web page, provide the complete URL.
(Linked pages open in a new browser window.)

Payment Information

Payment must be received before the publication date.

After receiving e-mail confirmation from the editor, make check payable to:
STC

Mail check to:
SD-STC
P.O. Box 501261
San Diego, CA 92150-1261

Advertising Policy

The publisher reserves the right to request revisions or to reject advertising.
The advertiser and the advertising agency assume liability for all content of
the advertisement published and for any claims arising thereof against the
publisher. The publisher is not liable for delays in the scheduled publication
dates beyond a refund of prepaid advertising space costs.

Liability

The advertiser shall indemnify and protect the publisher from claims or
expenses which may arise from the unauthorized use of any name,
photograph, drawing, or work protected by copyright, registration, or label
printed as a result of material supplied by the advertiser.
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Chapter President, Walter Hanig
wdhanig@alumni.rice.edu
Walter is responsible for a project converting a large suite of internal
and end-user documentation to structured FrameMaker 7 at NCR.

He has served the chapter as Finance Vice-President and
Administrative Council jester for four years before last year's
adventure as chapter president.

VP-Professional Develoment, Michelle Petersen
mpetersen3@cox.net
Michelle is a senior technical writer at Alaris Medical Systems in
Sorrento Mesa.

VP-Employment, Beth Peisic
bethpeisic@san.rr.com
Beth has a varied background in finance, accounting, and technical
communications. She is a Senior Technical Writer at Intuit.

VP-Finance, Lance-Robert
lance.robert@tarari.com
Lance-Robert is a senior technical publications engineer at Tarari,
Inc., in Rancho Bernardo.

VP-Membership, Sue Heim
sue_heim@msn.com
Sue is a technical writing consultant in San Diego. She previously
served in the San Diego Chapter as Vice President-Professional
Development and as JobMail coordinator.

VP-Programs, Michael Cárdenas
mcardenas@multitrans.com
Michael is president of Multilingual Translations, Inc., a localization
company headquartered in San Diego since 1985.

Newsletter Managing Editor, Catherine Robinson
stcsignature@yahoo.com
Catherine is a senior information engineer in the Teradata division at
NCR. She has enjoyed contributing her time and efforts to STC in the
capacity of judge of the technical writers' competition and
proofreader of the monthly newsletter.

Newsletter Assistant Editor, Jennifer Mallory
jmallory100@hotmail.com
After Jennifer graduated with a degree in literature, she waited for
the job offers to flood in. When the surprise and rejection wore off,
she began a lengthy career in marketing and editing. Currently,
Jennifer works as a Health Information Specialist II with the County
of San Diego.

Chapter Web Site Manager, Kelley Wilson Mesterharm
kelleyw@cox.net
Kelley has an instructional and curriculum design background with
experience in Web accessibility and usability.
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STC Mission Statement

Society for Technical
Communication
901 N. Stuart Street
Suite 904
Arlington, Virginia
22203-1822

703.522.4114 (voice)
703.522.2075 (fax)

E-mail: stc@stc.org Web
site: www.stc.org

Our mission statement is: Designing the future of technical
communication

The Society for Technical Communication (STC) is an individual
membership organization dedicated to advancing the arts and
sciences of technical communication. STC is the largest organization
of its type in the world. Its 25,000 members include technical
writers, editors, graphic designers, videographers, multimedia
artists, Web and Intranet page information designers, translators,
and others whose work involves making technical information
available to those who need it.

Society membership provides opportunities for ongoing learning and
professional networking. Through the efforts of a small, full-time
staff and a large network of volunteers, STC promotes the public
welfare by educating its members and industry about issues
concerning technical communication.

Member: $125 per year (plus a one-time $15 enrollment fee)●   

Student Member: $50 per year (enrollment fee not required)●   
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Sponsorship Opportunities
By Michael Cárdenas, VP Programs

Author Bio

Contact Michael

Would you like to promote your company, get your company name
recognition and, at the same time, help the San Diego STC Chapter? Well, we
have an excellent opportunity for you!

Your company can sponsor a monthly meeting. You will have your company
logo and name on the San Diego STC Web site; you will get additional
recognition at the STC meeting; and you will have a minute or two to present
your company's products and services to the meeting attendees.

The cost per presentation is $150. This includes dinner for one attendee, who
must register in advance of the meeting.

Please contact Michael Cárdenas for sponsorship opportunities:
Phone 619.295.2682 or email mcardenas@multitrans.com.
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Join STC
By Sue Heim, VP Membership

 Mission Statement: Creating and supporting a forum for
communities of practice in the profession of technical
communication.

The Society for Technical Communication (STC) is dedicated to advancing the
arts and sciences of technical communication. Celebrating its 50th
anniversary this year, STC is the largest organization of its type in the world.
Its 25,000 members in 150 chapters include technical writers and editors,
content developers, documentation specialists, technical illustrators,
instructional designers, academics, information architects, usability and
human factors professionals, visual designers, Web designers and
developers, translators, and others whose work involves making technical
information available to those who need it.

Society membership provides opportunities for ongoing learning and
professional networking. Through the efforts of a small, full-time staff and a
large network of volunteers, STC promotes the public welfare by educating
its members and industry about issues concerning technical communication.

 Society Goals
The goals of STC include enhancing the professionalism of the members and
the status of the profession; providing information through publications,
reports, and conferences; and reporting new communication technologies,
methods, and applications; among others.

In addition to the publications you will receive, you will have many
opportunities to further your own education by attending dinner
presentations, seminars, and conferences. You can submit your work in our
annual competitions and receive recognition and awards from your peers.
And you will have plenty of opportunity to network�to meet fellow STC
members.

Benefits of Membership
Among the benefits of Society membership are subscriptions to Intercom, the
Society's monthly magazine, published 10 times a year, and to Technical
Communication, the Society's quarterly journal. These periodicals contain
essential articles on the theory and practice of technical communication.

Other membership benefits include discounts on STC's annual conference,
the largest gathering of technical communicators in the world; eligibility for
association group-rate insurance; and access to STC's special interest
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groups. For more information on these and other benefits, visit the STC Web
site at www.stc.org.

How to Join
STC membership dues are paid per calendar year. Members who join after
February 1 receive a prorated "credit" on their next year's dues. Dues are as
follows:

Member: $140 per year (including a one-time $15 enrollment fee)●   

Student Member: $50 per year (no enrollment fee)●   

To join STC, you can fill out an electronic form or download a membership
application at www.stc.org. You can also contact the STC office at the
following address and request that a membership application be mailed to
you.

Society for Technical Communication
901 North Stuart Street, Suite 904
Arlington, VA 22203-1822
(703) 522-4114
stc@stc.org

For more information on the San Diego Chapter of STC, visit our Web site at
www.stc-sd.org or contact Sue Heim, vice president of Membership, at
sue_heim@msn.com.
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Project management
books used in the
course:

A Guide to the Project
Management Body of
Knowledge PMBOK Guide
2000, by the Project
Management Institute

Project Management by
Gary R. Heerkens

Managing Your Projects

By Catherine Robinson

In the October newsletter; I wrote about the value of project management.
Since I recently completed my project management course, I want to share
with you what I have learned.

The course, offered by UC Berkeley extension, used two books:
A Guide to the Project Management Body of Knowledge PMBOK Guide
2000, by the Project Management Institute.

●   

Project Management by Gary R. Heerkens.●   

The Project Management Institute defines project management as "the
application of knowledge, skills, tools, and techniques to project activities to
meet project requirements. Project management is accomplished through the
use of the processes such as: initiating, planning, executing, controlling, and
closing" (p. 6).

I'll briefly summarize what I learned.

Integration Management

Determine your problem or opportunity, understand your new project, decide
what you need to do (or not do), and then create your project plan. I decided
to focus on my volunteer position with the newsletter, so I considered my
managing editor role as I prepared my assignments. This approach helped
me to plan properly and wisely to begin producing a monthly newsletter.

Four thought processes were involved in developing my project plan:

Project Overview

Create/maintain a project team and prepare for the September 2003
publication of the STC newsletter.

Project Approach

The project will take into consideration the feasibility, planning, development,
and implementation of the project, and the project team resources.

Project Objectives
Keep STC members involved with the organization and informed on
technical communication trends within the industry.

●   

Produce an on-time monthly newsletter for STC members in HTML
format for the Web for the publication year September 2003 through
June 2004.

●   
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Produce a quality newsletter with at least one monthly feature article,
columns (such as humor and member profiles), and a possible monthly
theme.

●   

Major Deliverables
Monthly production schedule.●   

Initial run for the first publication due in September 2003.●   

Newsletter to include feature articles, columns (such as, humor and
member profiles), meeting announcements, technical publications
announcements, national conference announcements, and paid
advertising.

●   

Scope Management

Make sure your project plan is in line with the expectations of your boss (in
my case, in line with the needs of San Diego members). I had to define
within my project plan the tasks that needed to be done in order to get
contributor articles in on time, articles to copyeditors, copyedited material
back for production files, production files to proofreaders, proofreader
comments to the copyeditor, and then finalized comments back for final
modifications of the production files.

Time Management

Manage your project's time, so that you can schedule the sequence of tasks
that were defined when the project was scoped. Take into consideration the
efforts of the resources available to work on your project. Are they
experienced with the tasks involved, or are they learning in new roles? How
much time will each resource need to complete the necessary tasks? From
there, you can begin to anticipate the start and end dates of your project.

Cost Management

This is where you budget for your project's costs, trying to anticipate the
monies needed for all aspects of the project in order to complete it
successfully. The easiest way to begin this process is to look at previous
project budget costs, and then begin to figure out if and how your costs
differ, or if they actually remain the same as your previous project(s).

Quality Management

Focus on quality processes as you manage the project. I wrote up a quality
process to help the newsletter team understand the flow of our monthly
newsletter publication process. It explains why. how and when each phase of
the process is supposed to happen.

Human Resource Management

Managing the staff of a project either means continuing to work with the
same team or building a new team. If you are working with the same group
of people, hopefully they are reliable and great team players who have
worked well together in the past. On the other hand, you may need to hire a
whole or partially new staff, which means those team members involved will
need time and have to make the effort to get to know one another and learn
how each can work well with the other team members. Sometimes hiring
new staff members takes time for the project to get underway, so you have
to take this into consideration in your project plan. New members also have
to get up to speed on the products involved in the project, so training
schedules should be taken into consideration.
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Communications Management

Make sure you attend the right meetings, talk to the right people, inform
those who need to know about the progress of your project, or lack thereof,
and getting that information to the right people who may need to make
decisions about how your project should continue to move forward.

Risk Management

An important part of the process, performing a risk analysis will help you to
realize what the possible setbacks are and their solutions. From there you
can be better prepared rather than being blind-sided. This task helped me to
overcome my fears of the "what if's" and sensibly plan for those
unforeseeable events.

Procurement Management

Some aspects of your project could entail having to hire outside vendors or
contractors to get your project done on time. In my case, I have learned to
plan to arrive at monthly meetings early to network and share the newsletter
schedule and talk to our members about opportunities for them to contribute
articles.

I hope you have found my learning experience helpful. If we carefully
approach and plan for a project, we're more likely to be successful. I wish
you all the best in your future project management endeavors.

Signature: Feature Article

http://www.stc-sd.org/newsletter/january_2004/feature.htm (3 of 4) [12/31/2003 11:42:53 AM]



Return Home

Feature | Editor's Desk | President's Podium
Helpful Tips | Chapter Meetings

Humor | Professional Development | Employment Desired
Mission | Author Bios | Newsletter Staff | San Diego Chapter Council Members

Signature: Feature Article

http://www.stc-sd.org/newsletter/january_2004/feature.htm (4 of 4) [12/31/2003 11:42:53 AM]

http://www.stc-sd.org/newsletter/january_2004/bios.htm


January 2004 Humor

Return Home

What's So Funny?
By Karen Field Carroll

Author Bio

Contact Karen

I'm out of material. It had to happen eventually. Five years of
writing a humor column would make anyone a little too serious.
Actually, I'm impressed with my endurance: When I started writing
this column, I couldn't imagine finding so much material on a
profession as seemingly austere as technical communication. But
material abounds, or at least it did.

Looking back, I realize I had help. Microsoft is always an easy target.
So is any developer who acts like working for a software company is
the moral equivalent to curing cancer. Recruiters are ripe fruit too.
(Unfortunately, recruiters are necessary evils in job-hunting, so I bit
my tongue.) Marketing departments ooze topics for humor columns.
I've flung one or two zingers their way over the years.

Perhaps the biggest draw for humor, however, is not the people that
technical writing supports, but technical writing itself. Think about it:
People read us because they've messed up. They don't pick up our
book thinking, "Ah, my bedtime novel." Instead they're probably
wondering, "What the [bleep] have I done wrong?" Reaching for the
book is like admitting defeat. What a wonderful way to start a
relationship with a reader.

There are other plusses. We don't get a byline. We work under
pressure. In the high-tech industry, we're at the bottom of the food
chain. Scratch that: I think customer support is bottom, but we're
next up. (Ah, CS�Now there's a loaded subject.) People often see us
as typists.

These circumstances�that we write books people try to avoid
reading, that we get no recognition�have been the meat of my
humor column. But after five years, I've come up short. What is
funny about tech writing, really? It's fun, sure. (But don't tell your
relatives that. They think you have the most boring job in the world.
And they'll question your sanity if they find out you don't agree.) It's
good work. It pays well. But what's so funny about it?

Again I correct myself. What's funny about the profession is neither
the profession nor the people around it. Tech writers are the mad
hatters of technology. The developer ponders C code and scratches
his chin. The QA Jack or Jill draws up multi-level test plans with a
furrowed brow. The business manager calculates sales and profit
margins. And there we sit, telling people how to use a product that
(a) the developer thinks is so easy to use the manual is redundant;
(b) the QA person thinks is too complicated for us to understand,
much less write about; and (c) the business manager thinks is so
needed it will sell itself. Yet the company still pays us to show up and
write books every day. No one but us thinks the manual is
necessary. Oh, except the user. Now, if we could just get the users
to like us.
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Donald W. Bush
Celebrating 40 Years with STC!
By Sue Heim, VP Membership

 

 

Don enjoying the presentation

 

Don, surprised as Sue presents
him with a pen

On December 6 Don Bush celebrated his 40-year anniversary with STC�a
truly auspicious occasion. At our December dinner meeting, we honored Don
with a special presentation.

How His Story Began

Don's first technical communication job was in 1962 for McDonnell Aircraft. In
1961 Don was a journalism major working in public relations for
Southwestern Bell when he heard about the job at McDonnell Aircraft. They
wanted a "student of language" to help engineers write proposals. He was
hired in 1962 and worked as a proposal analyst until he retired after 25
years. After he retired from McDonnell Aircraft, Don began teaching at SDSU
where he taught for 11 years, until he retired from teaching.

Don joined STC (or rather, the Society of Technical Writers and Publishers) in
December 1963. In 1981 he became an Associate Fellow. In 1989 Don
became an STC Fellow. STC Fellowship is conferred on those who have
attained such eminence in the field of technical communication that the
Board, by a two-thirds vote of all members, deems them worthy of being
singled out as one of the select few who have distinguished the Society and
the profession.

Don is a prolific writer and editor. He has written two books and numerous
articles. He started writing articles for Technical Communication in 1980. In
1990 Don began writing a column for the same periodical, after the editor
talked him into it. Don continues to write "The Friendly Editor" for Intercom.
His most recent article appeared in the July/August issue and was titled "The
Most Obvious Fault in Technical Writing."

What He's Said

Don has written close to 30 articles for Intercom alone. Doing research for
his presentation, I read many of his articles. It was very hard to pick only a
few, but here are some of his more memorable quotes.

In "Ethics for Editors" in the January 1996 issue of Intercom, Don
wrote, "In addition to truth, fairness, and scientific objectivity, [we]
should embrace espousing the interests and welfare of the reader, not
just the publisher."

●   

In "The Most Obvious Fault in Technical Writing" in the July/August
2003 issue of Intercom, he wrote what is probably going to be one of
the most oft-repeated quotes "...the greatest fault in published
technical writing is not lack of grammar, consistency, or accuracy. Its
most obvious fault is something that's far easier to control: wordiness."

●   

In "How to Edit for Content" in the January 2003 issue of Intercom,
Don eloquently wrote, "An editor focuses on the most pertinent data

●   
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and aspires to make the language move the reader."

At the 1998 STC annual conference, Don presented a session on "The
Tantalizing Technology of English." During this session he said, "As
technical communicators, we have to know about management,
computer programming, graphics, production... and many other skills,
even keyboarding. But in professional technologies, we are not as
proficient as the experts. Our greatest chance to shine as a
professional is in the technology of English."

●   

In November 2000 Don was interviewed in Technical Communication. He was
asked what he thought to be the biggest changes in the technical
communication profession. He said it was something he didn�t want to dwell
on, but �&membership has dramatically changed. It used to be all old men.
Now it�s all young women!� (Have you looked around at our dinner
meetings lately? He�s not too far off!) Seriously, he was also quoted as
saying that �&writing has improved considerably [as] many STC members
are English majors.� He continued by saying that �We owe a debt to the
Fog Index. [The] use of short words and sentences has become essentially a
Bible for us in technical communication.�

To This Day

To this day, Don continues to support STC at the national and local levels. He
does this by mentoring other technical communications professionals, writing
articles for STC publications, and attending meetings. Thank you, Don, for all
that you�ve done for us!
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Ushering in the New Year
By Catherine Robinson, Managing Editor

If you find value in the
Signature newsletter,
consider contributing
articles. We need feature
articles, advice, technical
workarounds for
problems you have
encountered, and some
plain old helpful tips.

If you want to improve
your writing skills,
contribute articles. You
will have the opportunity
to work with our great
copyeditors who can give
you pointers and help
you improve your skills.

Contact us at:
stcsignature@yahoo.com.

A new year has just begun, causing us to reflect on what has been
and to look forward to what will be. As I reflect on the first quarter of
our 2003-2004 publishing season of the Signature newsletter, I see
a myriad of contributions including technical, helpful, and humorous
articles. These contributions have enriched our readers' lives as the
newsletter pages reveal the professional and personal qualities of the
good people of our small technical community. Their personal
contributions have made it possible for us to offer a monthly
newsletter to our chapter members. For all those contributions, I am
truly grateful.

Our newsletter staff has selflessly contributed their time and efforts
to get the newsletter published monthly. I appreciate this wonderful
group of people and the shared experiences.

As we look toward a new year, we hope to continue to share our
experiences and skills with all of you. If there is any way we can help
to enrich your lives further through our newsletter services, please
contact us at stcsignature@yahoo.com. We look forward to hearing
your fresh, new ideas. Do take care and have a wonderful new year.
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New Tricks
By Walter Hanig, President

Author Bio

Contact Walter

Administrative Council

The hardest part of writing this column is coming up with a topic, month after
month after month. I'm not shy about asking for suggestions and others
have not been shy about offering them. So, I'd like to use this space to list a
few of the tricks this old dog learned in 2003.

Finding a new job isn't that hard . . . if you do it often enough.
The gap between leaving Ericsson and joining NCR was a way-too-short
seven weeks. I can take no credit for the existence of the opening. But
I have no doubt that letting people know I was available and
face-to-face networking played major roles.

●   

Volunteers are easier to find if you ask them directly. I should
have learned this earlier, but sometimes begging is necessary. Sharon
Burton-Hardin, our November speaker, had said as much in an STC
leadership workshop.

●   

Box turtles need plenty of cool water and shade on hot days.
This was a sad lesson whose pain was slightly diminished with the
arrival of new babies, Pilgrim and Kamé, in November.

●   

The most effective motivation occurs after the fact. Two words,
sincerely communicated: "Thank you."

●   

Entry level jobs for applied math majors from UCLA are hard to
find. Contact me if you know of one.

●   

There is nothing like evacuating from home to help you decide
what material items are most important.

●   

Structured FrameMaker 7 is cool if your act is together,
templatewise. Otherwise, you're perfuming a pig.

●   

When it comes to training, you don't always get what you pay
for. The free XML/XSLT classes I took from the San Diego Centers for
Education & Technology http://www.sandiegocet.net were well-taught,
informative, and free. Actually, they were better than free because I
got a student ID card ($2) that allowed me to buy software at the
heavily discounted educational rate.

●   

Year after year, French Quarter Festival
http://www.frenchquarterfestival.com is the place to be in
mid-April.

●   
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Every company has a mind-numbing collection of abbreviations,
acronyms, and initialisms. It's taken me only six months to learn
that "CLI" doesn't always mean "command line interface."

●   

Likewise, every company has its own product development
process. However, all companies share a commitment to ignoring the
process when it suits them.

●   

Cooking for 25 loved ones at Thanksgiving isn't that hard when
some help with the preparation, cooking, and cleaning, others stay out
of the way, and others fetch rum and Coke. (Myers's Jamaican with
lime, if you please). And, yes, brining a turkey is a good idea!

●   
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Welcome to Our New Members
By Sue Heim, VP Membership

 

 

 

Welcome to our new members--whether new to STC or to our San Diego
Chapter.

New members

Virginia K. Guest
Katherine A. Vitz
Veronica S. Schnizler
Francesca Barr
Betsy L. Busby
Alana L. Krider

And to a returning member

Dawn M. Heller
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Members Looking for Work

Illustration © 2002
Ann M. Throckmorton

How to submit an ad

Ads are limited to STC members
and should not exceed 125 words.
Send your ad to the editor at
stcsignature@yahoo.com.

To ensure publication, we'll need
your ad by the 5th of the month
prior to publication. Ads received
after the 5th will be inserted if
possible.

You'll need to renew your ad for
each month you want it
published.

 

Julie Kinyoun
11457 Trailbrook Lane, San Diego, CA 92128
858-513-3811 (home); 619-248-9543 (work)
juliekinyoun@hotmail.com

Excellent writer and author of articles in both local and national
science publications. Possess masters degree in chemistry with over
a year of relevant pharmaceutical experience. Most recently, I wrote
phase I/III clinical research reports for Dermtech International in
San Diego. Desire contract or permanent work in technical writing.
Experienced with MS Office, Adobe Acrobat, ChemDraw, and MatLab.

M.A. Chemistry San Diego State University
Taught for general, organic and introductory chemistry laboratories;
and performed multi-step synthetic reactions and analyzed product
by NMR.

Work Experience

Dermtech International, 2003, Report Specialist
Wrote clinical reports.for phase I/III trials, and compiled data for
reports with MS Excel.

KPBS Television, 2003, Intern for "Full Focus"
Transcribed interviews using Executive Producer Program, and
performed background research with MS Word.

Idec Pharmaceuticals, Inc., 2000, Chemist for Quality Control
Performed routine testing on water samples for lead, and wrote
standard operating procedures and testing protocols.

Cell Therapeutics, Inc., 1999, Documentation Assistant
Organized and filed all cGMP/GLP documents for clinical trials, and
learned cGMP/GLP protocols and trial format- tracked on Excel.

Richard Garner
619-425-5279
rgarner_1998@hotmail.com

I am a recent graduate, (03/03), of the Certificate Program in
Technical and Scientific Writing at San Diego State University. I did
an internship with Consistent Image of San Diego, California, a small
consulting company that produces the manuals for Sprint Wireless
Communications. At Consistent Image I was responsible for
transferring two large documents from Quark Express 5.0 to
Framemaker 6.0 in precise template form. I also assisted the
company with several other print and online documents.

I also did much of the formatting and visual design work on a
volunteer student team that produced a revision of the Substitute
Teacher Handbook for the La Mesa-Spring Valley School District.

Seeking: A permanent or temporary position as a technical writer
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Education: Certificate in Technical and Scientific Writing,
San Diego State University; B.A. in history, University of California,
San Diego

Tools: FrameMaker 6.0, Acrobat 5.0, Word, Excel, HTML 4.0

Samples: I have writing samples available in FrameMaker 6.0 and
Word.
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January Chapter Meeting Preview: Using
Metrics to Tell Your Story
By Michael Cárdenas, VP Programs

Click here for January 14 meeting
details.

If you make a reservation but find
you cannot attend, please cancel
your reservation by sending an
e-mail to Lance-Robert at
treasurer@stc-sd.org. The chapter
has to pay the hotel for all
no-shows, which takes money
away from various programs that
could otherwise benefit the
chapter members.

There is no financial penalty for
cancelling your reservation. If you
used PayPal to pay for your
reservation in advance and need
to cancel, the full amount will be
refunded to your account within
three working days.

Metrics are just numbers. Understanding and using metrics gives a
manager valuable information on the performance of products,
projects, and people. Learn to identify which metrics can help you
tell the right story to your management.

About Deirdre Murr

As manager of the technical publications department for Walt Disney
Imagineering (WDI), Deirdre Murr supervises 17 people working on
over 200 projects with an annual operating and project budget of
more than $6 million. During her 20 years in the technical
communication field, she has spent ten years managing technical
writing departments and projects.

Her department at WDI is responsible for the development of repair
and maintenance manuals for all the attractions in the ten Disney
parks.

De joined STC in 1983, was elected associate fellow in 1994, and
was elected fellow in 2002. At the international and chapter levels,
she has served in a variety of positions, including chapter president,
for two chapters, Houston and San Fernando Valley. Houston
Chapter awarded her the Distinguished Chapter Service Award in
1995. At the Society level, De was elected to the Nominating
Committee in 2001.

De is also a member of the Association of Computing Machinery and
IEEE.
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December meeting attendance
numbers:

39 attendees
2 cancellations
5 no-shows
11 used PayPal

Walter Hanig, President & Sue
Heim, VP Membership

Michael Cárdenas, VP Programs

Don Bush, STC fellow, celebrating
40 years with STC

December Chapter Meeting Review

December meeting featured RJ Jacquez of eHelp
By Eric Hurd

San Diego Chapter Meeting - Wednesday, December 10, 2003

Walter Hanig opened the meeting by asking first-time attendees to
cite their reasons for coming and what they expected to get out of
the meeting. Some of the reasons included curiosity about the field,
desire to meet fellow writers for the first time, and interest in the
presentation.

Walter then invited the members who were looking for work to stand
and describe their skills and the type of work they seek. Then
members with job announcements were asked to stand and describe
the positions available.

Happy 40th Don!

After dinner, Sue Heim surprised Don Bush, who is celebrating his
40th year with STC, with a tribute. Don, an STC fellow, joined the
Saint Louis Chapter in 1963. For a more in-depth look at Don and his
involvement with STC, see Don's article: "The Most Obvious Fault in
Technical Writing,� in Intercom, 2003, volume 50, issue 7.

The following is a quote from Don that is, according to Sue, making
its way around the technical writing community:

�. . . the greatest fault in published technical writing is not lack of
grammar, consistency, or accuracy. Its most obvious fault is
something that�s far easier to control: wordiness.�

Announcements

All members are invited to drop off or pick up used books at the
�adopt-a-book� table before and after meetings.

Members may check out books from the STC library. If there is a
book that you are interested in reading that is not available, the
chapter will purchase a copy for the library if you review it for the
newsletter.

Walter thanked Sue Heim for putting together the nice tribute to
Don.

Walter also thanked Lance for making sure the Red Lion Hanalei, the
hotel where our meetings are now held, stays with our original menu
and pricing agreement. Our meetings will continue to be held there,
in Mission Valley, through spring. However, we are looking into new
sites for next year.

Kitt Medrano is starting a member-announcements column in this
newsletter. So, if you have news, promotions, or personal
announcements that you would like to share with STC, please
contact Kitt at kitt@wote.com.

Members will soon be receiving invitations to take an anonymous
online salary survey. We all benefit when as many writers as possible
participate. In addition to discovering where we stand in the market,
the data helps those of us seeking work to more successfully
negotiate salary.
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Don Bush honored on his 40th
anniversary with STC

Don's tribute included a special
tasty dessert

Don partaking in the tribute

RJ Jacquez, featured speaker from
eHelp

 

 

 

The San Diego Chapter has officially agreed to host the 2005 Region
8 conference. More details will be available in the near future.

RJ Jacquez on �The Next Generation of
Single-Source Tools for Adobe FrameMaker�

The evening�s featured speaker was RJ Jacquez from eHelp (soon to
be Macromedia). Jacquez is the product manager for FrameMaker
Technologies at eHelp Corporation. He has served as vice president
of technology for Quadralay and has most recently led a team at
eHelp to develop a single-source solution for FrameMaker users
�RoboHelp for FrameMaker.

Jacquez started with a little background about single sourcing before
discussing the goals of the application.

Deliver a great user experience.●   

Leverage users� existing knowledge of FrameMaker.●   

Provide a nonintrusive approach to single sourcing.●   

Go beyond the traditional single sourcing concept.●   

Support multiple books, variables, numbering, and all building
blocks.

●   

Go beyond the linear-based approach of simple conversion
tools.

●   

Jacquez spent the remainder of the presentation demonstrating the
product. The following are some of the highlights.

RoboHelp for FrameMaker can replicate the styles of the input
Frame files. Users can also modify the styles without touching
the source files.

●   

A single project can include multiple books as source files.●   

Cross references are automatically resolved.●   

Live connectivity keeps the project in sync with the source
files.

●   

Conditional text can be set for each type of output.●   

Non-FrameMaker content can be imported.●   

A quick-review feature allows the user to update the styles on
the fly without compiling the entire project.

●   

RoboHelp for FrameMaker incorporates the FrameMaker
numbering engine so that all numbering is correct regardless
of what is included or excluded.

●   

The paragraph designer allows the user to assign attributes to
multiple styles at once.

●   
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RoboHelp for FrameMaker supports FlashHelp, HTML, MS HTML
Help, and Web Help.

●   

The index, table of contents, and glossary can be modified
separately for each output type.

●   

For more information about this product, visit www.eHelp.com (soon
to be www.macromedia.com).

Jacquez wrapped up his presentation with a round of questions from
the audience. Concerns were raised about lack of support for
JavaHelp and separate styles for the output; but, overall, the tour
was well received.

After the questions, Jacquez conducted a drawing for a full copy of
RoboHelp for FrameMaker. James Guarino was the luck winner.

Meeting Wrapup

Our monthly giveaway winners were:
Roberta Davidson and Beth Peisic, who both won STC
business card holders.

●   

Susan Self and Lesley Robin, who won �Magic Cube� office
supplies.

●   

Pamela Peterburg, who won this month's "Wally Buck," good
for a free San Diego Chapter dinner and presentation.

●   

Thank you for coming. We'll see you next year!

Roberta Davidson

Beth Peisic
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Susan Self

Lesley Robin

Pamela Peterburg
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Winter Quarter Classes for Technical
Communicators Offered by UC Extension
By Michelle Petersen, VP Professional Development

 Many of us know that UC San Diego and UC Riverside offer Certificates in
Technical Communication through their University Extension programs.
However, did you know that you can take technical communication classes
through these campuses without enrolling in the Certificate program? Classes
for Winter 2004 start in January.

UCSD Technical Communication Courses (Winter 2004)

Course: Critical Thinking for Technical Communicators
Teacher: Bonni Graham
Course Dates: January 7-March 3
Description from the UCSD Extension Web site:

"This course explores how decisions made before the writing
process begins can have unexpected ramifications. Students will
examine their thinking processes�how they use reason to solve
problems, form opinions, and make decisions�in order to
improve them. They will practice identifying key questions and
assumptions, assessing interpretations and conclusions, and
applying criteria and standards to analysis. Course will be taught
through lectures, discussions, and technical writing exercises and
projects."

Course: Information Design for Technical Communicators
Teacher: Steve Margolin
Course Dates: February 10-March 16
Description from the UCSD Extension Web site:

"Professionals who produce technical communications�whether
they are technical writers, Web and graphic designers, trainers,
or engineers�can benefit from knowledge of document design. In
broad terms, document design is the integration of words and
pictures to help readers satisfy their goals for using the
document. We will study how to use clear writing, analysis of the
audience's needs, legibility of typography, design of spatial cues,
and the interplay of words and pictures to create documents,
printed or electronic, that readers understand and respond to
aesthetically and emotionally."

To enroll in these classes or to view the entire course catalog, visit the UCSD
Extension Web site:

http://www.extension.ucsd.edu

You may also enroll over the phone by calling UCSD Extension at
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(858)534-3400.

UC Riverside Technical Communication Courses (Winter 2004)

Course: Managing Technical Communication Projects
Teacher: Sharon Burton
Course Dates: January 12-March 29
Description from the UC Riverside Extension Web site:

"This course focuses on the management of technical writing
projects. The entire process of technical documentation of
projects is examined, including determining the project scope,
developing the information plan, estimating page counts,
planning milestones and ensuring quality. Creating and updating
project plans, documentation plans and content plans are also
covered."

Course: FrameMaker: Software for Creating Technical Documents
Teacher: Bonni Graham
Course Dates: January 24-February 28
Description from the UC Riverside Extension Web site:

"This course provides hands-on instruction in one of the most
essential tools in the field of technical writing today: Adobe
FrameMaker. With FrameMaker, writers can create and manage
complex multichapter documents with significant cost reduction,
and the handling and creation of tables of contents, indices,
cross-references, tables of figures, bibliographies, and other
document components can be automated. FrameMaker can also
turn documentation into HTML pages and Adobe PDF files."

To enroll in these classes or to view the entire course catalog, visit the UC
Riverside Extension Web site:

http://www.ucrextension.net

You may also enroll over the phone by calling UC Riverside Extension at
(909)787-4105 or toll-free (800)442-4990.
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Market Changes Afoot: What Do They Mean
for Technical Communicators?

By Rahel Anne Bailie, STC Director/Sponsor for Region 7

 One of my activities as a self-employed consultant is to monitor various job
boards. The job boards I monitor include positions and contracts for technical
communicators, but more importantly, they include positions for the
industries we support: software development, engineering, and
manufacturing. This gives me a daily temperature reading on the industry
where I'm most likely to find clients and contracts.

In November, the activity on the job boards shot up. Between Nov 21 and
28, 2003, one Vancouver job board had 163 jobs posted, with almost a
dozen of them being communication-related jobs: technical writer,
instructional designer, marketing communications manager. This encouraging
news was confirmed by a consultant from Boston, whose business suddenly
got very busy; all consultants in his firm are fully booked. Does this mean
that the economy is bouncing back, and what does this mean for technical
communication professionals? How can we reconcile this apparent economic
recovery with the opposing trend of jobs moving from North America to Asian
countries?

Certainly, the increase in North American jobs is encouraging for North
American technical communicators, just as the surge of product development
in countries such as Singapore, India, and China is encouraging for technical
communicators there. Generally speaking, product development generally
indicates a corollary need to communicate product features through
marketing communications, the user interface, user instructions, and internal
documentation; and the communication jobs are kept in close proximity to
the development jobs.

We must keep in mind, however, that as markets mature�and the software
industry, where so many technical communicators are employed, is maturing
along with all other industries�and profit margins narrow, companies
continue to find ways to be competitive. We consumers like our software to
be inexpensive, and we hunt around for the very best deals. To provide us
with those deals, companies need to find ways to cut costs, then cut costs
more, and then cut costs even more. In an industry with few raw materials,
where the largest expense is the brain power of its staff, the way to cut
development costs is to cut labour costs. If work can be fit into a formula and
done where labour costs are less, that will happen.

From my Canadian perspective (keeping in mind that Canada was one of the
first countries to which American companies sent their work "off-shore"), I
see the current migration of jobs around the globe as inevitable. As much of
the hard-goods manufacturing of the world has gone to China, thereby
stocking North American dollar stores with inexpensive merchandise, so
follows the knowledge industry to satisfy the market demand for discounted
products.
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What this means for me as a technical communicator based in North America
is that I need to make strategic career choices. If I choose to specialize in the
type of work that is moving to another part of the world, I can look harder to
do that type of work locally, or I can follow the work to wherever it goes, the
way that actors migrate to Los Angeles. Or I can choose to look for the type
of technical communication work that, by necessity, stays closer to home. I
would tap into communities adjacent to technical communication to
encourage cross-pollination of ideas and see what types of work is suited to
someone with my abilities, work that doesn't come with the title of "technical
writer" but involves using my skill set and qualifications. I would build my
network outside of the technical communication community, getting to know
the decision-makers in new areas and getting known there as well.

What it would mean for me as a technical communicator based in a country
with an emerging economy is that I would want to build my credibility as a
professional who delivers top-quality work that satisfies the demands of a
head office that may be overseas. I would tap into the body of knowledge
that exists in print and online to find a way to exceed the documentation
standards out there, and deliver work that meets the needs of clients and
end users. I'd find out what makes the market tick and figure out where my
skills should be going. I would find a colleague or peer as a mentor. I would
connect into existing technical communication communities, attend meetings,
take courses, and subscribe to listservs. I'd cultivate a "buddy" relationship
with a technical communicator in my area of interest and find ways to share
information about the demands of technical communication in various
markets around the world. I'd look at trends and determine what's coming so
I could stay current and not lose my work in a year (or two, or five) to
another country with even lower labour costs. I'd ensure that my company
knows, every step of the way, how much value I add to the product and the
company, and make management see that I am a value contributor instead
of a cost centre.

The next few years will be very interesting times. From new tools, such as
software that writes instructions by recording screen actions as you complete
tasks on screen and creates content objects for content management
systems, to new trends that include moving jobs around the world in a global
economy, we are continually made to examine our personal employment
situations and our profession to look for interesting opportunities.
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Creating Simple Forms in Microsoft® Word
By Gail Van Landingham

Has a friend ever stopped by and shown you a technique that was
immediately useful in your job? Here's a suggestion you might find useful if
you need to collect a lot of information about people: try using Word forms
and import the information you receive into a database or spreadsheet.
Learning to do it takes only a few minutes.

The basic process is five steps:
Create a form.1.  
Lock it so the participants can only provide answers, not change your
questions.

2.  

Test the form.3.  
Save just the answers, not the questions.4.  
Import the answers into another program, like a database or
spreadsheet.

5.  

The Process

Before you start, sketch out your form on paper.
Create the form.

Open a new Word document.❍   

Display the Forms tool. Click View > Toolbars > Forms.❍   

Turn on field shading so you can see your form fields.❍   

Add one of the form fields. You can select Text, Checkbox, or
Drop-down from the Forms Toolbar.

❍   

The Forms Toolbar looks like this with field shading on.

When you finish, your form will look like this.

1.  
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Lock the form.
Protect the form so the users can enter data only in the fields.

Click Tools > Protect Document.❍   

Select Forms.❍   

When you finish, your form will look like this.

Save the form.

2.  

Test the form.
Give your form to a few friends and ask them to complete the fields
and send the form back to you. This is a small usability test.

3.  

Save the form.

Save the data as a CSV (comma-separated value) file.❍   

Click Tools > Options > Save❍   

Select Save data only for forms.❍   

Word saves the file with a TXT extension. Each field ends in a comma.

4.  

Import the form.
Import the TXT file into a database or spreadsheet. For details, see
Online Help in your database or spreadsheet program.

5.  

More Information

An organization for forms design
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Form designers have their own organization: the BFMA (Business Forms
Management Association), whose mission is to "address the unique
educational and networking needs of forms designers and managers"
(www.bfma.org).

Advanced form features
For details on more advanced form features in Word, see "Using Word's User
Forms," in Intercom, June 2003. This is on the STC site's members-only
password-protected area.
(http://www.stc.org/). Click the Members Only tab > Pubs search.

Future developments for forms
Microsoft Office 2003 has built-in XML capability. For one review, see
"Microsoft Reboots Office" by Jon Udell. He says, "XML capabilities in Word,
Excel, and InfoPath help bridge the gap between desktop documents and
databases, and give enterprises a reason to upgrade."
(http://www.infoworld.com/article/03/10/03/39FEoffice_1.html?s=feature).
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FrameMaker Autonumbering, Part 3

Finally, the Rest of the Article!
By Matt Sullivan

Author Bio

Contact Matt

In the first installment of this article, I discussed the prep work for
setting up chapter numbering. (See the Numbering1 link at
http://www.grafixtraining.com/stc/stc.html.)

The second installment discussed the codes needed for the following
tags:

ChapterTitle●   

Heading1●   

Heading2●   

(See the Numbering2 link at
http://www.grafixtraining.com/stc/stc.html.)

This month I'll finish the rest of the tags in my sample template. The
additional tags are as follows:

FigureTitle●   

TableTitle●   

NumberedList●   

ListIntro●   

Sublist●   

I will also discuss the use of Series Indicators (in the NumberedList
section) to reduce the number of codes needed for the overall
system.

FigureTitle

Following the FigureTitle sample text, we see that the Figure Title
should start with the Fig. 1-4 sample text. (See Fig. 1-4 sample at
http://www.grafixtraining.com/stc/2003/articleoct03/Numbering.pdf.
In this sample text, we see that the FigureTitle should start with the
Fig. text, followed by a reference to the chapter number, or the
<$chapnum> building block.)

Next, we have a dilemma. We need to increment the FigureTitle
counter (our fourth-level autonumber), but we need a way to get
past the counters for the second- and third-level autonumbers (the
Heading1 and Heading2 tags).

Now is when we go back to the four questions on the prep
worksheet.

Do I display the value?●   

Do I increment the value?●   
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Does the value reset?●   

If so, where do I reset?●   

For the second level (Heading1), we ask if we want the current
Heading1 value displayed in the FigureTitle. (We don't!)

Next, should the Heading1 value increment at this point? (No)

Does it reset? (No)

Because it doesn't reset, we don't care about the last question at this
point.

With this set of answers, we really need something that will bypass
the Heading1 counter for now. That brings us to the Placeholder code
introduced last month. By typing

< >

(ensuring that both brackets are on the same line [with a space
between the brackets] in the final document to avoid confusion), we
tell Frame that we don't want to display the number (because we
haven't specified a format such as A, a, R, r, or n), and we also tell
Frame that we don't want to change the value because we have
neither the + nor = symbols.

Next, we repeat the same exercise for the Heading2 tag. (After the
same process, we find the Placeholder is the appropriate code at this
point as well.) This gives us a current string of

<$chapnum>-< >< >

which will be followed by our fourth autonumber code for the
FigureTitle, itself.

This final code should be an incrementing value that resets at the
ChapterTitle level, or an Increment code (<n+>). Finishing with a
colon at the end of the FigureTitle code gives us

<$chapnum>-< >< ><n+>:

Because our figures will reset at the chapter level, the Numbering
Properties dialog will control the FigureTitle reset.

Note: In this case, we've already set the Paragraph tab of the
Numbering Properties to reset our paragraph numbering while we
were developing the Heading1 tag. So we're done with the
FigureTitle tag.

TableTitle

Because the FigureTitle tag is so similar to this one, let's skip to
putting in a placeholder for the FigureTitle counter, giving us

Table <$chapnum>-< >< >< >
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As with the FigureTitle, the TableTitle also increments and resets at
the ChapterTitle level, so we finish with an increment code and a
colon, giving us

Table <$chapnum>-< >< >< ><n+>:

Note: Remember that the TableTitle will reset at the Chapter level
and has been previously set. 

ListItems

Frame template designers divide into two camps when it comes to
list numbering. Some take the simpler approach and have a list reset
tag (such as Numbered1) and an increment tag (such as Numbered).
Though this system works just fine, I'm in the other camp.

For my templates, I like to minimize the number of tags in my
Paragraph Catalog as well as control my numbering on the basis of
context rather than the explicit tag. (I like to control the number by
its position within a list rather than using extra tags to reset.) I see
an advantage in being able to reorder my list items (including the
first item in the list) without worrying about whether my formatting
(in this case, my numbering) is still correct.

Here are some examples of how I like to control nested lists.

NumberedList

Initially, the toughest thing about our sixth autonumber is that it
doesn't display the NumberedList itelf�the two are still linked. All
the placeholders need to be able to get to the sixth position.
Fortunately, Frame allows something called a Series Indicator,
which is a convention for bypassing the autonumbers linked to the
ChapterTitle tag.

Series Indicator is defined as a two-digit prefix to the Autonumber
Format, consisting of any keyboard character and a colon.

When we use this convention, along with the answers to the four
questions on the prep worksheet and our example text, our
NumberedList format looks like this:

L:<n+>.\t

This list will reset at the beginning of the next list. Thus, we can't
rely on the Paragraph tab in the Numbering Properties dialog to
simply reset it at the beginning of the chapter. There are many
strategies for this reset, but my favorite is to use a tag called
ListIntro, which then calls up NumberedList as the Next Paragraph.

ListIntro

With formatting roughly equivalent to that used for basic content
(Body in my templates), the ListIntro has an Autonumber Format
that resets the NumberedList paragraph. The reset code is

< =0>, so the final code for this tag is L:< =0>

Sublist
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Even though the Sublist example text doesn't display the
NumberedList, itself, the two are still linked. After we look at the
example text and answer the four questions for each level of Sublist,
we have

L:< ><n+>

The reset for Sublist should occur at each instance of ListIntro. So, if
a Sublist is part of the template, we need to modify the
NumberedList tag to include the reset code, resulting in

L:<n+>< =0>.\t

Well, that's it folks. The next time you find yourself autonumbering
in Frame, I hope this information leads you down an easier path.
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